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About this Manual 

 

Purpose 

This manual has been written to help you understand and use the Jensor application. It presents the 

functional capabilities and operational details of Jensor, and contains the procedures that you should 

know for performing your business tasks using Jensor. Additionally, this manual provides information 

on the system requirements and installation of Jensor.  

Intended Audience 

This manual is intended for Java Developers, Testers, Production Support personnel and Project 

Managers who manage Java-based projects or products. 

 

Pre-requisites 

Following are the pre-requisites for performing the tasks presented in this manual: 

Functional The reader is expected to know how Java 

language executes a program and how to 

configure Java in his / her environment. The 

reader should be familiar with analysis 

techniques that helps one detect and eliminate 

bottlenecks in a program. Programming skills in 

Java is an added advantage.  

Technical The reader is expected to know the following 

1. Syntax to execute Java programs 

2. Knowledge on how to set up / deploy the 

target environment in which the Java 

application will be executed. 

3. Good analytical skills. 

 

Organisation of the Manual 

Information in this manual has been organised as follows: 

Table 1: Organisation of the Document 

Chapter Description 

Chapter 1 Gives details of the new features included in this version of Jensor. 

Chapter 2 Provides a brief introduction and conceptual model of Jensor. It also details the 
hardware and software requirements, and interfaces with other systems. 
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Chapter Description 

Chapter 3 Takes you on a quick tour of Jensor. It gives a brief introduction about the 
general working features of Jensor that you should keep in mind while working. 

Chapter 4 This chapter covers details about Jensor administration. The administrative tasks 
are pre-requisites before a remote JVM can be monitored. 

Chapter 5 Introduction to a Jensor Project 

Chapter 6 Jensor usage methodology is a simple 3 step process viz. Instrument – Deploy –
Profile. This chapter covers it in detail. 

Chapter 7 This chapter describes the usage of Jensor Analysis Workbench from command 
line. 

Chapter 8 This chapter describes Jensor Analysis Workbench. 

Chapter 9 This chapter explains Jensor reports in detail. 

Appendix Covers Jensor Calibration Results, Resources and Roadmap 

 

Typographical Conventions 

The following table gives the details of the typographical conventions used in the document: 

Table 2: Typographical Conventions 

Formatting 
Convention 

Type of Information 

Key Names Keys on the keyboard appear in title case (first letter in upper case). 
For example, Page Up, Caps Lock. 

A combination of keys is connected by a +. For example, Shift + Tab 
means you should press the Shift key and Tab key together. 

Filenames Names of files and directories are in italics. Example, System.mdb. 

Command and Screen 
element names 

Buttons, check boxes, etc. Commands that you choose from the 
menus or dialog boxes appear in title case and are bold-faced.  

Example: Click Instrument from the Mode menu. 

User-entered text Text that you would need to enter appears in Verdana font 

 

Feedback and Suggestions 

Send your feedback and suggestions to amol.khanapurkar@tcs.com or chetan1.phalak@tcs.com 

 

mailto:amol.khanapurkar@tcs.com
mailto:chetan1.phalak@tcs.com
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Abbreviation/ 
Acronym 

Description  
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JDF Jensor Discussion Forum 
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PERC Performance Engineering Research Centre 

RAM Random Access Memory 

UI User Interface 

pdf Probability Density Function 

cdf Cumulative Distribution Function 

Table 1.  Acronyms 
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1 What is new in Jensor v2.2? 

Jensor v2.2 has added following features in this release. 

 

1.1 Probability Density Function Graph 

Now, Analysis of method‟s response times becomes easy than earlier. Jensor v2.2 introduces new 

analytical module Probability Density Function (pdf). This module will represent response times in 

graphical format. User can collectively choose more than one function and plot the pdf graph on 

single screen. This pdf graph will answer the question, “How frequent are response time samples at 

exactly this value?” 

For ex. 20% of total collection of response time samples are of 170 milliseconds. 

User can get this graph by navigating to Mode  Analyze  Probability Density Function 

 

1.2 Cumulative Distribution Function Graph 

In section 1.1 we saw newly introduced analytical module pdf. Similarly one more Jensor v2.2 

introduces one more module Cumulative Distribution Function (cdf). Similar to pdf, user can plot more 

than one function‟s cdf on single screen. This cdf graph will help user to find answer of the question, 

“How frequent are response time samples that are less than or equal to this value?” 

For ex. 80% of total collection of response time samples are less than or equal to 1 second. 

User can get this graph by navigating to Mode  Analyze  Cumulative Distribution 

Function 

 

1.3 UI ease and enhancement 

1.3.1 Displaying current sessions name 

Lower panel of the JAW used to display current project name and java heap usage of JAW. Now 

Jensor v2.2 onwards, same lower panel will also display current session‟s name on right hand side. 

This will help user to easily keep a track between data shown in JAW modules (graphically or 

numerically) and session name.  

1.3.2 Dynamic removal of un-used tabs 

Jensor Analysis Workbench has five fixed tabs on the main panel and other module‟s tab gets added 

to panel as per user requirement. To make main panel less crowded, Jensor v2.2 onwards the tab of 

the module of which data is not been collected will not occupy space on main panel. 

For eg. If for any particular session system metrics is not collected then when user will click on tab of 

„System Metrics‟ that tab will disappear from the JAW main panel. 
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1.3.3 Showing proper display messages  

Earlier in Jensor, users not used to get proper information messages regarding data or status. Jensor 

v2.2 has included several display messages at appropriate locations and situations. 

For eg. If system metrics is not collected for particular session then popup displays the message of 

related content. 

 

1.4 Bug Fixes 

1.4.1 Sorting in Executive Summary 

There were two issues with sorting in Executive Summary module.  

 90
th
 Percentile column does not participate in sort if it is selected as second order for sorting. 

 Self Time column does not participate in sorting at all. 

Both of these bugs are fixed in Jensor v2.2 and now values of all seven columns of executive 

summary gets sorted correctly irrespective of the order of sorting.  

1.4.2 Storing session’s data 

Jensor was not able to save data in appropriate order if number of sessions in particular project 

exceeds to two digits. Jensor v2.2 is with fix of this bug and it is capable of storing data of session 

though count of sessions is greater than nine. 

1.4.3 Collation using command line utility 

Jensor used to show FileNotFoundException during collation using command line utility. Due to 

elimination of this bug from Jensor, collation process using command line utility works perfectly in 

Jensor v2.2.  

1.4.4 Exporting tags 

Jensor was not able to export all tags, taginit and Tag.properties files from one project to another 

project. Along with this, cancel action of export tags to another location used to result in error. 

Jensor v2.2 is released with removal of these bugs. 

1.4.5 User Interface bugs 

After selection of any tab of JAW, the same module‟s display process used to get invoked. But in 
earlier versions of Jensor Response Time Based Statistical Analysis tab not used to play its part in 
routine process. Now onwards, from Jensor v2.2 user will not face this smaller UI bug. 
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2 Introduction 

This section provides an overview of the chapter. 

2.1 Introduction to Jensor 

Jensor is a light-weight and a low-overhead Java Profiler. Jensor is designed to be fit for use under 

Production workloads. Jensor uses byte code instrumentation to obtain method response times and 

memory consumption details. Jensor 2.2 provides fourteen (14) different analysis tools to detect 

bottlenecks in the code. 

Jensor provides many useful features which are useful to a developer during Development cycle. 

Jensor has a very negligible overhead which makes it useful in Test and Production environments. 

Thus Jensor provides a common mechanism for a developer, a tester and a production support 

personnel to troubleshoot performance defects. Jensor also has the unique ability of providing 

business perspective using technical data. This feature is very useful to project managers. 

 

2.2 Features of Jensor 

The following are some important features of Jensor: 

 Has extremely low overheads (1 to 5 microseconds per method) and low memory footprint 
(typically less than 1 MB). 

 Can automatically instrument java classes at load time and you can control which ones 
should get instrumented. 

 Can carry out Adaptive Profiling. It can track its own overheads. 

 Can provide method response time for all pure Java methods. 

 Provides Heap Utilization statistics and Object allocation details, which can be used to 
ascertain if there are memory leaks in the application. 

 Provides fourteen different analysis tools to detect bottlenecks 

 Can provide a business as well as technical view based on the same underlying data 

 Can do remote JVM monitoring 

 Capable of Method-level Filtering while monitoring 

 Capable of establishing multiple Jensor‟s instances on single machine to monitor as many 
JVMs as desired on that machine. 
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2.3 Jensor Architecture 

This section describes Jensor architecture 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1. Jensor Architecture 

 
Jensor consists of 3 logical components 

1) Instrumentation Engine – This is invoked statically and consists of Byte Code Reader, 
Transformer and Writer 

 
2) Jensor Core

1
 – Jensor Core comes into play when instrumented code is executed. The Core 

consists of 3 components 
a. Log Writer for generating logs to be analyzed offline. 
b. Real-Time Statistics Engine for monitoring memory consumption and identifying 

bottleneck methods at run-time 
c. Control Engine – This controls Jensor behaviour at runtime. 
d. TCP / IP Server – Accepts signals to start / stop and collate Jensor data from local or 

remote JAW. 
 

3) Jensor Analysis Workbench (JAW)
2
 – This is invoked offline after Jensor output is obtained. It 

consists currently of 13 features viz. 
a. Executive Summary Report - This module crunches Jensor logs and generates 

Executive Summary Report which gives unique method‟s statistics across all threads. 
b. Call Trace – Creates entire call execution sequence with break up of response time at 

each level. 
c. JVM Replay – Allows replay of method executions happening in JVM. This feature 

can be useful in debugging reliability and scalability problems. 
d. Pattern Analysis Engine – This identifies patterns of interest from application 

performance perspective. This component contains 2 patterns viz. Elementary and 
Advance pattern analysis. Only Elementary pattern Analysis is shipped with this 
version of Jensor. Advance Pattern Analysis will be distributed in later releases. 

                                                      
1
 Jensor Core was called Profiling Engine in Jensor version 1.1 

2
 Jensor Analysis Workbench (JAW) was called Analysis Engine in Jensor version 1.1 

Instrumentation Engine Jensor Core 
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e. Charting Engine – It currently provides graphical visualization for correlating method 
response time histograms and memory utilization. 

f. Un-exited Methods – This module provides useful pointers into debugging reliability of 
the application. Two modules provide information about un-exited methods. 

g. Tagging – Three modules in Jensor are dedicated to tagging. Tagging is the process 
in which one declares „Tags‟. Next tags are applied to technical data obtained from 
Jensor. Jensor then provides break-up and visualization based on Tags. Further 
more, Tags can be nested to bring out appropriate correlation between different 
categories of tags. Using tags it is possible to create a business perspective of 
technical data. 

h. Response Time Spectrum – Averages typically dilute information about response 
time. This module depicts response time of all occurrences of selected methods 
against wall clock time. This module enables identifying periods of the day where a 
method performance degraded and by how much. 

i. Probability Density Function of Response Time – This module will represent response 
times in graphical format. User can collectively choose more than one function and 
plot the pdf graph on single screen. This pdf graph will answer the question, “How 
common are response time samples at exactly this value?” 

j. Cumulative Distribution Function of Response Time – User can plot more than one 
function‟s cdf on single screen. This cdf graph will help user to find answer of the 
question, “How common are response time samples that are less than or equal to this 
value?” 

k. Object Instantiations – Shows memory graph and details about object allocations 
grouped by methods. This module allows one to select time range and get 
information about allocated object type and allocating method along with count of 
number of objects allocated. A high allocation of a particular object type within a  
method can provide useful pointers to memory consumption by that method. 

l. System Metrics - Shows data related to System Utilization. This module helps the 
user to identify any significant changes in certain System Utilization metrics. 

m. Response Time based Statistical Analysis – Provides a statistical analysis of the 
method response times. 
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2.4 Jensor Conceptual Model 

This section describes the conceptual model behind Jensor 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2. Jensor Conceptual Model 

 

Conceptual model of Jensor comprises primarily of 4 components viz. 

1) Jensor Core, referred to as Jensor in rest of the document. The Core consists of 

a. Filters – Not discussed in this document (FT) 

b. Aggregators – Not discussed in this document (AG) 

c. Control Engine – Described in chapter 6 (CE) 

d. TCP / IP Server -  Described in chapter 3 (TCP) 

2) Jensor Communication Engine (JCE) 

3) Persistent Data Store (PDS) 

4) Jensor Analysis Workbench (JAW) 
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For Jensor to be able to capture data from a Java application, the application needs to be Jensor-

enabled. One needs to perform instrumentation to Jensor-enable an application. Instrumentation can 

be performed on command line as well as using JAW UI. Once the instrumented code is deployed 

back in the target environment Jensor Core captures response times and memory utilization data. 

This data is stored in Persistent Data Store which currently, in this release of Jensor is a file on the file 

system. This data needs to be crunched using Jensor Analysis Workbench (JAW) . The JAW can 

either be on the same system as Jensor or it can reside on a remote machine. The JAW can be used 

to send signals to Jensor to start / stop and collate data. If the JAW resides on a remote machine, the 

remote machine IP address as well as the current logged in user need to be authorized to be allowed 

to access Jensor data. If the JAW resides on the same machine, access to Jensor data is granted by 

default. Upon successful System as well as User authorization Jensor data is transferred over TCP / 

IP to remote JAW. This is called Collation of Records in Jensor terminology. Collating records causes 

Jensor to stop collecting data. Explicit start session command needs to be issued through JAW to 

restart the data collection. All the communication between Jensor Core and JAW happens through 

JCE which uses TCP / IP protocol for transmitting signals and data. 
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2.5 Jensor Environment 

This section describes the hardware and software environment required to run Jensor. 

2.5.1 Software Environment 

Operating System Any Operating System supporting JDK 1.5 and JDK 1.6 

JDK / JRE version Java 1.5 and JDK 1.6 

Table 2 Software Environment 

2.5.2 Hardware Environment 

Machine Architecture Any hardware type supporting JDK 1.5 and JDK 1.6 

RAM 512 MB RAM recommended 

CPU Speed Intel, AMD – 1+ GHz  
Sun, IBM – 450+ MHz  

Disk Space Minimum 2 GB Free Disk Space 

Table 3. Hardware Environment 

 

2.6 Additional Configuration Settings 

Jensor installer for Windows creates environment variable called JENSOR_HOME. If admin rights are 

not available, environment variable will need to be created manually. To create environment variable 

on Windows go to Control Panel -> System -> Advanced -> Environment Variables. 

JENSOR_HOME will need to be assigned value of the directory where Jensor was installed, typically 

C:\Program Files\Jensor. 

 

On Unix, add JENSOR_HOME environment variable to your profile file. JENSOR_HOME should be 

assigned the value where Jensor was extracted to. For example, if you untar-ed Jensor into 

/home/perf then JENSOR_HOME should be assigned the value /home/perf/Jensor. Consult your 

system administrator for syntax for setting environment variables for your flavour of Unix operating 

system. 
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3 Getting Started 

This section provides chapter overview. 

3.1 Starting and Quitting Jensor 

To launch Jensor execute the startup script loacated in %JENSOR_HOME%/bin. On Windows the file 

name is startup.bat and on Unix the file name is startup.sh. On Unix check that execute permissions 

are granted for startup.sh. Upon Jensor launch, the following Java Swing based UI is launched. 

 

 

 

 

 

 

Fig. 3. Jensor Login 

Use Administrator as username and perf123 as password to log in to Jensor. Upon successful log in 

you will see the following screen. Click on Help -> Version to verify that current version is Jensor 2.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4. Jensor UI 

 

 



Jensor 2.2 Usage Manual 

      10
  

3.2 Working with the Jensor Interface 

Jensor UI is a simple UI developed in Java Swing. It consists of a Menu bar and a Status Bar. The UI 

consists of 4 menus viz. File, Administration, Mode and Help. The Status bar provides information 

about Jensor‟s memory consumption and current project in use. 

3.2.1 Using Menus and Toolbars 

This section provides details about using the menus 

You can use menu to access Jensor functionality to perform BCI, analyse output and do 

administrative tasks.  

The File menu consists of 6 menu items viz. 

 New :- Creates a new Jensor Project 

 Open :- Opens an existing Jensor Project 

 Delete Project :- Deletes the Project from local file system 

 Delete Session :- Deletes the selected Session from the currently open project 

 Close :- Closes an existing Jensor Project 

 Exit :- Exits Jensor UI 

 

The Administration menu is only available to the administrator. Default password of this user is 

perf123. This menu consists of 3 menu items viz. 

 Change Password :- Changes password of existing user(s) 

 System Admin :- Allows administrator to add a list of systems which can remotely 

access Jensor data on this machine. 

 User Admin :- Allows administrator to add / remove and grant access to users. 

Different kinds of access rights in Jensor include  

o Start Session – Send signal to Jensor using local / remote JAW to start 

capturing data 

o Stop Session - Send signal to Jensor using local / remote JAW to stop 

capturing data 

o Collate Records – Send signal to Jensor to stop capturing data and transfer 

already collected data to local / remote JAW 

o Perform GC – Send a signal to Jensor to call the Garbage Collector 

 

The Mode menu consists of 8 menu items viz. 

 Instrument :- Opens Jensor UI for performing instrumentation 
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 Start Session :- Asks information regarding host and port where Jensor is running 

and then sends signal to that JVM to start collecting data. Valid authentication 

credentials on remote JVM are required for this to work. 

 Stop Session :- Asks information regarding host and port where Jensor is running 

and then sends signal to that JVM to stop collecting data. Valid authentication 

credentials on remote JVM are required for this to work. 

 Collate Records :- Asks information regarding host and port where Jensor is running 

and then sends signal to that JVM to stop collecting data and then transfer already 

collected data to JAW. Valid authentication credentials on remote JVM are required 

for this to work. 

 Offline Collation:- Asks for the zip file containing the Jensor logs. This feature is 

useful where the files may exist on a remote server but it may be a challenge to 

transfer the logs (for example huge size file transfer on a low bandwidth etc) on to the 

JAW machine. In such cases , the user can use the Offline collation feature. The 

steps to be followed are as follows 

o Zip the contents of the %JENSOR_HOME%\output directory, namely 

JensorProfile.txt, memusage.csv, topNMethods.csv, ObjectInst.txt and 

SystemUtilization.txt files. Not all files are necessary. This module can create 

appropriate analysis reports based on what files are contained in the zip. The 

mapping of files to analysis modules is as follows 

 Memusage.csv – Charts -> Memory Utilization 

 topNMethods.csv – Charts -> Method Histogram 

 ObjectInst.txt -> Object Instantiations 

 SystemUtilization.txt -> System Metrics 

 JensorProfile.txt -> Everything else 

So if any of the files is missing, corresponding analysis module wont get data. 

o Copy the zip file from the remote machine onto the local machine 

o Direct the JAW to the zip file on the local machine. 

o If the Project for which the logs were collected does not exist on the JAW, a 

new Project will be created. Else the logs will form a new session under the 

existing project. 

 Perform GC :- Asks information regarding host and port where Jensor is running and 

then sends signal to that JVM to perform the Garbage Collection. On return it displays 

the amount of free memory before GC as well as that after GC. 

 Analyze :- Jensor provides 11 different analysis tools for analyzing output. Analysis 

tools are available as sub-menu items. 

o Executive Summary Report :- Provides summary report of Jensor output 

o Call Trace :- Provides method call trace based on Jensor output 
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o JVM Replay :- Provides replay method call sequence in the JVM. The call 

sequance can be animated to debug performance, scalability and reliability 

problems. 

o Pattern Analysis :- Captures patterns in Jensor output 

o Charts :- Provides method response time histogram and memory utilization 

charts. The histogram and memory utilization charts can be animated to 

obtain correlation between method response times and memory utilization. 

o Response-time Spectrum :- Provides method response time details in form 

of a spectrum. Zoom-in and zoom-out features aid in detailed analysis of 

method response times. 

o Probability Density Function :- Provides method response time details in 

form of a pdf. This pdf graph will answer the question, “How common are 

response time samples at exactly this value?” 

o Cumulative Distribution Function :- Provides method response time details 

in form of a cdf. This cdf graph will answer the question, “How common are 

response time samples at less than or equal to this value?”  

o Unexited :- Provides information about methods that do not / abnormally exit. 

o Rebuild :- Rebuilds all analysis reports from original files belonging to a 

given session. 

o Tagging :- This sub-menu is used for using Tagging functionality. This is 

explained in detail in 9.7 

o Object Instantiations :- Provides details regarding the objects that were 

instantiated during the time period selected. This is explained in 9.9 

 Change Session :- Provides screen to change current working session. At point of 

time during data analysis user can change the current working session. 

 Change Properties :- Provides screen to change Jensor UI configurations. Most 

notably, you can alter the depth of call trace and pattern analysis by changing 

configurations here. 

 



Jensor 2.2 Usage Manual 

      13
  

 
 

 

Fig. 5. Jensor UI Menus 

 

The Help menu consists of 3 menu items viz. 

 About Us :- Self-explanatory 

 Terms and Conditions :- Contains acknowledgements and credits to authors of 

other software used in Jensor.  

 Version :- Version and build date of installed copy of Jensor. 

 

3.2.2 Using Shortcut Keys 

The shortcut keys for invoking menu as well as sub-menu is marked with respective mnemonics. The 

following examples demonstrate use of shortcut keys. 

 

For Mode Menu – Alt + M 

For Mode - Analyze – Alt + M + A 

For Mode – Analyze – Executive Summary Report – Alt + M + A + E 

 



Jensor 2.2 Usage Manual 

      14
  

 

 

3.2.3 Create Multiple Jensor Instances 

Multiple Jensor instances can be created for multiple JVMs. One has to navigate through START 

menu on windows. The specific path is START > Jensor > Create Multiple Jensor Instances. 

 

 

 

 

 

 

 
 

Fig. 6. Jensor Multiple Home UI 

 

To create new Jensor instance one has to provide port other than one, which used earlier for Jensor. 
Note: The very first and default instance of Jensor runs works on port 21999. Along with new port 
value, the Jensor home of new instance need to be provided. To achieve this one can click on browse 
button and needs to navigate to the required folder. If user wants to create same project directories in 
the new Jensor Instance as present in default one, the check box needed to be checked.  
 
 The Validate button is provided on the panel which will validate both the inputs provided by 
user and only after successful validation the Create button will get enabled. When user will click on 
Create button, the new Jensor‟s instance creation process will start and after completion the popup 
will be displayed with the information, which includes the number of Jensor‟s instance on the system 
and the JENSOR_HOME value of that respective instance. 
 
 For in detail description of multi-instance Jensor, user can refer the Features Guide provided 
in Jensor documents. 
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3.3 Usage Methodology 

This section describes Jensor‟s usage methodology, covering the 3-step process of Instrument, 

Deploy and Profile and also describes the process to be followed to create multiple jensor‟s instance. 

 

3.3.1 Instrument 

Jensor works on Byte Code Instrumentation (BCI) technique. For Jensor to be able to capture data 

Java classes need to be instrumented. This version of Jensor requires manual instrumentation. Future 

versions of Jensor will support automatic instrumentation. Instrumentation is supported through 

Instrument menu item in Jensor UI. 

Jensor works on the concept of a “Project”. To instrument Java classes, one creates a Jensor Project 

through UI. Next, Jensor will need to be navigated to location of class or jar or war or ear files which 

need to be instrumented. Before Instrumenting, Jensor will backup a copy of original uninstrumented 

code. It will then instrument the code and keep the instrumented code in “instrumented” directory 

under the project. 

 

3.3.2 Deploy 

One will then need to pick up the Instrumented code from “instrumented” directory of the 

corresponding Jensor Project. This instrumented code will then be required to be deployed in the 

target environment using ones own deployment methodology. Also Jensor Jar jensorjdk15-<version>-

<platform>, contained in JENSOR_HOME/lib directory will need to be in application classpath. 

Note:- It is necessary to ensure that the deployment process does not compile application 

code. Compiling will remove Jensor instrumentation. This typically happens when using IDEs 

like Eclipse etc., to deploy application code. 

 

3.3.3 Profile 

Once deployment is successful, profiling data will automatically be collected in files in 

JENSOR_HOME/output directory. After Collate Records, the data is automatically shipped to 

appropriate project folder. 
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4 Jensor Administration 

4.1 Introduction to Jensor Administration 

This section provides an overview of administrative tasks that can be performed in Jensor. 

 

The Administration module deals with creating secure environment between JAW and Jensor. It is a 

rudimentary attempt to provide security to captured profiling data. The security principles are as 

follows 

1) Who is allowed to access profiling data? and 

2) From what systems? 

Consider the following scenario to understand the security mechanism in Jensor. Say, machine A is 

the server which runs application X and say machine B is the developer workstation. The developer 

wants to profile application X running on server A. S /he instruments the code and deploys it on 

machine A. Now, if the developer wants to access the profiling data sitting on his/ her machine B the 

following steps need to be followed. 

1) Create System account in machine A for machine B 

a. Launch JAW on server A 

b. Go to Administration -> System Admin 

c. Enter IP address or hostname of machine B 

2) Create User account in machine A 

a. Launch JAW on server A 

b. Go to Administration -> User Admin -> Add User 

c. Create a user and share the username / password with the developer 

3) Create same User account in machine B i.e the developer machine 

a. Launch JAW on server A 

b. Go to Administration -> User Admin -> Add User 

c. Create a user and share the username / password with the developer 

 

Developer will now be able to start / stop and collate data from remote Jensor running in JVM of 

application X deployed on machine A. There are certain “project” logistics that one needs to handle. 

These will be explained in section 5.1 
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4.2 Assigning User Access Privileges 

There are 3 different privileges that a user has viz.  

 Start session 

 Stop Session 

 Collate Records 

 

A user with Start Session privilege can send signal to local or remote Jensor to start capturing data. 

Similarly a user with Stop Session privilege can send signal to local or remote Jensor to stop 

capturing data. Collate Records privilege implies Stop Session privileges since Jensor first stops data 

collection and then collates and sends data to local or remote JAW. In case of remote JAW files are 

transferred over TCP / IP. Hence any TCP / IP level tuning at OS layer can be performed to speedup 

file transfers.  

 

The User Interfaces to add / remove users and change password / grant privileges are self-

explanatory and are hence not explained. 

 

NOTE :- The Administration menu is available to only administrator user with default password 

perf123. A guest user with password perf123 is also shipped by default 

 

4.3 Jensor Sessions 

Data collected between a Start Session and Collate Records signal essentially forms a Jensor 

session. Stop Session signal only stops capturing the application data. Collate Records signal stops 

Jensor and transfer file to local or remote JAW as the case may be. 

 

Sessions are related to a given Jensor “project”. Jensor can detect whether or not a given session 

belongs to a given project in JAW since the project information is embedded at instrumentation time. 

Hence it is important to use right “project” to collate data from right servers. More details will be 

explained in section 5.1  

 

4.4 Accounting Information for interaction with Core 

Any signals from local or remote JAW are logged into a file called accounting.log in 

$JENSOR_HOME\output directory on the server where Jensor enabled application or the Jensor 

Core is running. Hence all interaction like starting a session, stopping a session or collating records 

are written to this file.  
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5 Jensor Project 

This section provides an overview of Jensor Project 

5.1 What is a Jensor Project? 

Jensor project is a context of execution. One creates a Jensor project for the following reasons 

1. To store and retrieve analysis modules. 

2. In 1.x versions - To instrument java class and jars/wars/ears of interest. Since 2.x, 

there is no need for manual instrumentation. However, if you do need to manually 

instrument your classes for some reason, please consult Jensor 1.14 Usage Manual 

Jensor project resides as a directory on the file system. When a project is created, Jensor creates a 

directory by the same name as the project inside JENSOR_HOME/projects directory. The newly 

created project directory contains 3 more sub-directories viz. 

 Bin :- All analysis results are stored into and retrieved from this directory. User should 

not modify this directory or its contents. 

 Instrumented :- Once instrumentation is carried out through Jensor UI, this directory 

contains the instrumented code. Again, Jensor 2.x onwards, there is no need for 

manual instrumentation this directory will remain empty. This directory structure is 

retained for backward compatibility. 

 Unistrumented :- Before the selected code the instrumented, Jensor backs up original 

copy of the code. This directory will contain the original uninstrumented code. Again, 

Since 2.x, there is no need for manual instrumentation this directory will remain 

empty. This directory structure is retained for backward compatibility. 

All three directories are initially empty. They get populated as operations are performed 

through Jensor UI. The following picture shows an example 

 

  

  

 

 

 

 

  

 

Fig. 7 Jensor Directory Structure 
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5.1.1 Creating a Jensor Project 

This section describes the steps to create a Jensor project. 

 

1. Go to JENSOR_HOME/bin and execute startup.bat or ./startup.sh as appropriate.  

2. Jensor UI will be launched. Navigate to File –> New or press Alt + F + N 

3. Name the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 8. Creating Jensor Project 

 

This will create a directory called Test in JENSOR_HOME/projects. The „Test‟ directory will consist of 

3 empty sub-directories viz bin, instrumented and uninstrumented. The fully qualified path of these 

directories will be JENSOR_HOME/projects/Test/bin, JENSOR_HOME/projects/Test/instrumented 

and JENSOR_HOME/projects/Test/uninstrumented respectively. 
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6 Instrument-Deploy-Profile 

This section provides detailed information on Jensor usage methodology. It explains the steps that 

one needs to follow to get Jensor up and running in desired environments {Dev, Test, Prod} 

 

6.1 Instrumenting Desired Classes and Jars/Wars/Ears 

Previous version of Jensor didn‟t support automatic instrumentation. Automatic instrumentation is 

instrumentation performed at class load time. JDK 1.5 offers Instrumentation API which Jensor uses 

to perform Load Time instrumentation. The code remains instrumented until it is unloaded by the JVM 

or until the JVM reboots. Class unloading is not typical. Hence for all practical purposes it is fair to 

consider that the instrumented classes will remain so until the JVM reboots. Jensor provides control to 

the user to override which classes should be instrumented and which classes should not be 

instrumented 

To instruct Jensor to instrument classes of interest, do as follows 

1) Go to %JENSOR_HOME%\config directory 

2) Open file includelist.txt. Create this file manually if this does not exist. 

3) Add the names of packages or classes you wish to instrument 

 Each line should contain either a package name or a classname 

 Only one entry per line 

 All classes inside a given package will be instrumented. 

 All packages inside a given package will be instrumented. Hence if you don‟t want certain 

packages instrumented, then you need to provide fully qualified package names of those 

that should be instrumented. 

 Any class / package name that is not included in this list will not be instrumented 

 It does not matter whether the class is inside a jar/war or an ear, at class load time they 

are all treated equally by the JVM. Hence you need not bother about specifying which file 

they are contained in. 

4) The instrumented classes will remain instrumented for its lifetime in the JVM. 

5) To get the instrumented classes to emit data, follow instructions in the Deploy section 

 

If for some reason you prefer to or need to instrument the code manually, refer Jensor 1.14 Usage 

Manual for detailed instruction on doing so. 

 

NOTE :- Effect of instrumenting JDK classes is unknown. Make sure you never add a JDK 

class or package name in includelist.txt 
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6.2 Deploying Jensor 

Until Jensor 2.x, deployment used to be a 2-step process viz. 

1. Pickup Instrumented Code from Jensor Project 

2. Adding Jensor Jar to classpath 

These change, started from version 2.x. In the new method one needs to add –javaagent switch to 

the command which boots the JVM. The steps are explained below 

 

6.2.1 Load Jensor as a Java Agent 

Lets understand this based on Jensor sample application that gets installed with Jensor installation.  

1. Open %JENSOR_HOME%\examples\demo.bat on Windows or 

$JENSOR_HOME\examples\demo.sh on Unix platforms 

2. You will find text similar to java -javaagent:"%JENSOR_HOME%\lib\jensorjdk15-v22-

win32.jar"=project=demo=config.file="%JENSOR_HOME%/config/Jensor.properties" -

Xmx64M -cp Java2Demo.jar; java2d.Java2Demo 

3. Lets concentrate on java -javaagent:"%JENSOR_HOME%\lib\jensorjdk15-v22-

win32.jar"=project=demo=config.file="%JENSOR_HOME%/config/Jensor.properties". 

This line consists of 3 parts. The remaining portion i.e. -Xmx64M -cp Java2Demo.jar; 

java2d.Java2Demo is something everybody is aware of and needs no explanation 

4. The –javagent: switch loads the classes in the jar "%JENSOR_HOME%\lib\jensorjdk15-v22-

win32.jar" as an agent. The agent classes are guaranteed to load before Application classes. 

For Jensor to perform class load time instrumentation this is necessary. 

5. Next, the part "=project=demo=config.file="%JENSOR_HOME%/config/Jensor.properties" are 

arguments to Jensor. The project argument to Jensor is the project name under which this 

data can be collected for analysis. The config.file provides startup paramters to Jensor. These 

are described in later sections. This file can be located anywhere on the file system. Jensor 

installation places one in ="%JENSOR_HOME%/config/ folder which users need to provide. 

Jensor will not be able to detect the location of this file automatically. 

6. By virtue of being loaded as an Agent, Jensor library i.e. jensorjdk15-v22-<platform>.jar need 

not be separately added to classpath. It already is in classpath. 

7. The general format of the javaagent switch is –javaagent:<Jensor Jar 

Name>=project=<project name>=config.file=<Path to Jensor.properties file> where 

a. –javaagent: which needs to immediately follow the keyword java 

b. project name can be any string which uniquely identified this project. A project by 

this name needs to be created in JAW to be able to pull data from the server 

c. Path to Jensor.properties – Jensor.properties contains all the Jensor startup 

configurations. Jensor will start as per configurations mentioned here in. 
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For application servers, one needs to modify the startup scripts or provide JVM parameters similar to 

one above, if installed as a service. 

 

6.2.2 Example configuration – Deploying Jensor on Tomcat 

Tomcat allows one to set up a parameter called JAVA_OPTS in its startup script called catalina,bat or 

catalina.sh. This is located in bin directory under Tomcat installation directory. Set up JAVA_OPTS as 

follows 

set JAVA_OPTS=-javaagent:"%JENSOR_HOME%\lib\jensorjdk15-v22-

win32.jar"=project=Tomcat=config.file="%JENSOR_HOME%\config\Jensor.properties" -

Xms1024M -Xmx1536M 

Usually, the startup script looks like this 

%_EXECJAVA% %JAVA_OPTS% %CATALINA_OPTS% %DEBUG_OPTS% -

Djava.endorsed.dirs="%JAVA_ENDORSED_DIRS%" -classpath "%CLASSPATH%" -

Dcatalina.base="%CATALINA_BASE%" -Dcatalina.home="%CATALINA_HOME%" -

Djava.io.tmpdir="%CATALINA_TMPDIR%" %MAINCLASS% %CMD_LINE_ARGS% %ACTION% 

 

If your catalina file looks like this, you are setup and good to go. The %EXECJAVA% invokes java 

and %JAVA_OPTS% sets up Jensor to be loaded as an Agent. If your startup script does not look like 

this, you need to add javaagent switch, as explained previously, to your java invocation command. 

 

6.3 Profiling the Jensor Instrumented Application 

Once the javaagent switch is successfully configured in target environment, Jensor will start writing 3 

logs files to %JENSOR_HOME%\output directory viz. 

1. JensorProfile.txt – contains Jensor logs. 

2. memusage.csv – contains memory snapshot taken every configurable interval of time. 

3. topNMethods.csv – contains instantaneous list of bottleneck methods identified every 

configurable interval of time. 

 

All files are written to until a Collate Records signal is received. Upon collation Jensor transfers data 

to JAW using JCE. All files in %JENSOR_HOME%\output folder are truncated. Jensor begins 

rewriting these files when a Start Session signal is issued. 

 

Every collation corresponds to one session. All analysis modules can be analyzed on a per session 

basis. It is a good idea to collate records in periods of no or low activity in the target application. 
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What and how Jensor captures data can be configured. Some of the parameters are configurable 

through Jensor.properties file in $JENSOR_HOME/config directory whereas some some can be done 

through Jensor Control Engine. The properties that can be configured through Jensor.properties are 

as follows 

 

JENSOR_HOME= 

This parameter is useful if you wish to setup more than one Jensor instance. Otherwise, leave it 

blank. Leaving it blank will default to value provided environment properties. 

 

PROFILE_CRITERIA=INCLUDELIST 

Leave this parameter unchanged. This will be harnessed effectively in later releases. DO NOT 

CHANGE the value of this parameter. 

 

LOG=true 

Turns Jensor logging on or off 

 

NUM_EXPENSIVE_METHODS=15 

Capture top <N> bottleneck methods in real-time. Default is 15. 

 

REFRESH_INTERVAL=5000 

Take memory snapshots once every <N> milliseconds. Default is 5000 milliseconds. 

 

JENSOR_PORT=21999 

Port on which Jensor TCP / IP Server listens for the commands from JAW to Start/Stop and Collate 

records.  

 

 

TCPIP_BUFFER_SIZE=8192 

Buffer size in bytes, used for the transfer of data files to remote JAW. This parameter can be tuned to 

speed up data transfers over network. 

 

 

START_AT_APPLICATION_BOOT=true 

Indicates whether to start data collection during application startup or not. When set to false Jensor 

will not capture data unless explicit signals are sent through JAW to start data collection. This option 

is useful when one wants to capture Jensor data only in particular locality of the application. 

 

CAPTURE_OBJECT_INSTANTIATION=false 

Indicates whether Object Instantiation related data has to be captured. This option can be turned off, if 

collecting Object Instantiation data proves too expensive. The default value is false. 
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CAPTURE_SYSTEM_UTILIZATION=true 

Captures System utilization. It captures only metrics for 4 objects viz. CPU, RAM, Disk and Network. 

Also this is the system utilization, not necessarily JVM utilization. On Windows this data is collected 

using typeperf and on Unix using sar command. The default is to capture System utilization. 

 

 

MIN_RESP_TIME_THRESHOLD=0 

Show methods only whose response time is greater than the set threshold. The threshold is value in 

milliseconds. Any response times lesser than set threshold will never be seen in Jensor reports. This 

parameter is also very useful in letting Jensor learn which methods to instrument and which ones to 

ignore. 

 

ENABLE_STATE_MACHINE=true 

This property lets Jensor decide which methods are worth instrumenting and which are not. Jensor 

decides this based on MIN_RESP_TIME_THRESHOLD parameter. If this property is set to true, 

Jensor will prune the result set i.e. profiling output. A detailed explanation of how this property works 

will be put up on Jensor blog and a separate document shortly. It is highly recommended that this 

value be set to true. 
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7 JAW on command line 

This section provides detailed information on Jensor usage methodology. It emphasizes more on 

session creation on command line. 

7.1 Starting session from command line. 

 

1. Execute startsession.bat or startsession.sh as per your platform. 

2. You need to provide two arguments, IP address of system on which instrumented application 

is running and port number through which you want to receive data. 

For ex: startsession.bat 192.168.140.11 21999 

3. The command window will ask for Username and Password, session will start only if 

username and password is valid. 

 

7.2 Stopping session from command line. 

 

1. Execute stopsession.bat or stopsession.sh as per your platform. 

2. You need to provide two arguments, IP address of system on which instrumented application 

is running and port number through which you want to receive data. 

For ex: stopsession.bat 192.168.140.11 21999 

3. The command window will ask for Username and Password, session will stop only if 

username and password is valid. 

 

7.3 Collation from command line. 

 

1. Execute collation.bat or collation.sh as per your platform. 

2. You need to provide three arguments, IP address of system on which instrumented 

application is running, port number through which you want to receive data and the projects 

name. 

For ex: stopsession.bat 192.168.140.11 21999 DemoProject 

3. The command window will ask for Username and Password, collation process will start only if 

username and password is valid. 
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8 Jensor Analysis Workbench 

Jensor Analysis Workbench provides 14 different tools/ modules for analyzing Jensor output. Some 

modules (like Pattern Analysis) aggregate performance data while some (like Debug Tree) perform 

drill-down. Using multiple modules in conjunction helps in sharpening the analysis. JAW aims at 

accelarating time taken to locate and eliminate bottlenecks in a given code by providing various ways 

of looking at the same data. 

JAW also includes Tagging Engine which helps in extracting business information based on technical 

output produced by Jensor. 

 

8.1 Using JAW 

8.1.1 Launching the Analysis Module 

Launch Jensor UI using startup script in JENSOR_HOME/bin. Open a Jensor project and navigate to 

Mode -> Analyze. Jensor presents 14 different modules to analyze output collected by Jensor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig. 9. Launching JAW 
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9 Reports 

Jensor provides the following types of reports.  

1. Executive Summary Report – A sheet presenting method statistics across all threads. 

2. Call Trace / Debug Tree – Reproduces order of execution of methods in a given thread. 

3. JVM Replay – Animated replay of all instrumented methods across all threads. 

4. Pattern Analysis – An aggregation tool to identify bottleneck call patterns. A pattern is a set 

of method calls. Optimizing a pattern has cascading effects on JVM performance. 

5. Charts – This module pictorially depicts bottleneck methods at any instant of time correlated 

with Java Heap memory consumption. 

6. Unexited – Provides a list of methods which do not exit normally. 

7. Unexited Details – Provides a call trace of methods which do not exit normally. 

8. Tagging – Allows creation of tags. Tags can be used for technical as well as business 

analysis. For e.g. Technical tags could be {JSP, EJB, JDBC, MDB} and Business Tags could 

be {Deposit, Withdrawal, Enquiry} etc. 

9. Simple Tagging (Pie-chart) – Response times broken up as per a given set of tags. For e.g. 

response times could be broken up into time spent in JSP, EJB, JDBC, MDB etc.  

10. Advance Tagging (Nested Pie-chart) – Allows nesting of tags, so one can answer questions 

like how much of response time of say Withdrawal transaction is spent in JDBC or say which 

transaction spends most time in JSP? 

11. Response Time Spectrum – A spectrum-like representation of method response time v/s 

time of the day. A response time spectrum provides more accurate picture of response time 

behavior since the data is not normalized using averages. 

12. Probability Density Function :- Provides method response time details in form of a pdf. This 

pdf graph will answer the question, “How common are response time samples at exactly this 

value?” 

13. Cumulative Distribution Function :- Provides method response time details in form of a cdf. 

This cdf graph will answer the question, “How common are response time samples at less 

than or equal to this value? 

14. System Metrics – Provides the user with a view into the details of the System in terms of the 

Processor, Memory, Network and Disk metrics. 

15. Executive Summary – Across all threads unique methods statistics sheet  

 

Detailed description is provided in next sections. All the reports below are invoked after launching 

Jensor UI and opening a project. Only after opening a project, the Mode menu in Jensor UI gets 

activated. Navigate to Mode -> Analyze to invoke the desired report. 
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9.1 Viewing the Executive Summary 

Executive Summary module of Jensor can be invoked through Mode -> Analyze -> Executive 

Summary. A Executive Summary provides unique method statistics across all threads sorted on 

response time as follows 

 Number of invocations of a particular method across all threads. 

 Total time spent across all calls to that method in all threads in milliseconds. 

 Average, Maximum and Minimum response time in milliseconds.   

 90
th
 percentile Response time for each method. 

 Total self time spent across all calls to that method in all threads in milliseconds 

An example is provided below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 10. Executive Summary 

 

The first red rectangle above shows that there were 56923 invocations of java2d.Surface.paint() 

across all  threads. All 56923 invocations completed in 896724 milliseconds with avg, max and min 

response times for this function in this thread equal to 15, 5922 and 15 milliseconds respectively. The 

last two columns display the 90
th
 percentile value of response time and the Time spent in Self of that 

particular method respectively. 

Below, two red rectangles show summary statistics of number and total counts of unique methods. 
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9.2 Viewing the Call Trace Report 

Debug Trace provides a call trace of the application i.e. it provides a “who called who” graph. 

Response time break-up can be obtained using this report. A Debug Trace can be invoked navigating 

Mode -> Analyze -> Debug Tree menu. There are 4 panels on this screen. Each of them is labelled 

appropriately in the diagram and explained below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Fig. 11. Debug Tree / Call Trace 

Call Tree Panel:- Depicts entire call trace for all threads. Time consuming method calls are painted in 

red and more frequently called methods are painted in blue. From Jensor v1.7 onwards, a search 

facility has been provided. 

Sometimes it is desirable to search within the call trees for manually tracking certain methods. The 

Call Trace, Pattern Analysis, Unexited and Unexited –Details module present data in form of call 

trees. This version of Jensor provides facility to search for and navigate to desired methods in these 

trees. The procedure to do so is as follows 

User need not to traverse the whole tree and all functions to find the bottleneck methods. Each 

function node in call tree will be tagged by the percentage response time taken by that same function 

among all methods which falls under same thread. i.e. all method gets called under one thread. 

 In Fig. 11, the green box depicts the two methods, where one method took 89.01% of execution time 

while other spent 10.91% of execution time in the thread name Arcs_curves.Arc Demo. As both of 

these methods response time is more than 10%, they are highlighted in red colour. This number is 

mentioned in DebugTrace.properties file against the parameter named TOP_N_PERC. 
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Operational Details for Searching Call Trees 

For searching the Call Tree, the user needs to focus on the Call Tree and then type the fully qualified 

Node name s/he wants to search for. With every change in the string, the search is refreshed and the 

appropriate node will be highlighted. If there is more than one node satisfying the criteria, then the 

user can scroll through the nodes by using the up and down arrow keys. To come out of the Search 

mode, the user must press the „Esc‟ Key on the keyboard. 

Extended Operational Details for Searching Call Trees 

The search feature can be controlled by setting the value of the property “TREE_SEARCH” in the file 

DebugTrace.properties, which exists in $JENSOR_HOME\projects\<project_name>\bin folder. The 

following settings are available: 

 “ON” – By setting the TREE_SEARCH value to ON the user can forcibly enable the search 

feature. 

 “OFF” – By setting the TREE_SEARCH value to OFF the user can forcibly disable the search 

feature. 

  “AUTO” – By default, the value of the variable is AUTO. In this case, if the number of nodes 

are more than 50000 then the search feature is automatically turned OFF else the search 

feature is turned ON. 

Thread Panel:- Provides thread list to quickly locate and analyze events in a given thread. 

Method Detail Panel: - Provides details about the last selected method calls. The panel holds a table 

with 8 columns, viz. 

 Function Name :- Name of the method 

 Tags :- If a method is tagged, this column depicts those tags, else it is blank. 

 Entry time :- This column is currently masked out in this version. Future versions on 

Jensor will populate this column with method entry time. 

 Call Count :- This version of Jensor will always report it as 1 (one). When Jensor 

supports folding information like say detecting loops or recursion, this column will 

actually depict time taken for a loop or a recursive call to finish. 

 Total / Avg / Max / Min Response times (in milliseconds) – Since call count is 1 (one), 

all 4 columns report the same value. 

To clear the rows in panel 3, use CLEAR TABLE button. By default Jensor UI show 31 last 

selected me methods. To change this setting, go to Mode -> Change Properties and change 

the number of last selected method calls. All time consuming methods in this table are 

highlighted in red colour. 

TopNMethod Panel:- This panel has many sub-panels. One corresponding to each thread plus one 

for aggregating information across all threads. By default the ALL tab is open. It provides information 

about bottleneck methods and the thread it is located in. The other tabs are named same as the 

thread names and provide response time information about bottleneck methods in this thread. 
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9.3 Using JVM Replay 

JVM Replay is useful in replaying the call method call sequence. It can be invoked by navigating 

Mode -> Analyze -> JVM Replay menu. The JVM Replay module animates the call sequence across 

all threads. This helps in investigating scalability as well as reliability problems. 

 
Fig. 12.  JVM Replay 

 

Use the Play, Pause and Stop buttons to control the animation. You can slow down the animation by 

adding delay. The table represents a call trace. The table has 7 columns viz. 

1. Function Name :- Name of the function 

2. Entry Time :- Relative time in milliseconds since invocation of the first Jensor-enabled method 

in the JVM. The red rectangle on top is start time in milliseconds since epoch i.e 1st January 

1970, 0:00:00, GMT 

3. Call Count :- Number of invocation of this method. 

4. Total / Avg / Max / Min response time in milliseconds. 
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9.4 Analysing Method Call Patterns 

Jensor is capable of detecting patterns in Java code. A pattern is a set of method calls. For e.g. if 

method A calls method B which calls method C, then Jensor reports 3 patterns viz. 

Pattern 1 : A() 

Pattern 2 : A() – B() 

Pattern 3 : A() – B() – C() 

Pattern Analysis module can be invoked using Mode -> Analyze -> Pattern Analysis menus. 

Future versions of Jensor will be able to identify that all three patterns are in fact a part of the same 

call sequence. Pattern Analysis is a powerful tool, since it aggregates the data as well as provides 

granular information about each method call. Optimizing a method call can provide local benefits, but 

optimizing a pattern can have cascading effects on application and JVM performance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 13. Pattern Analysis 

 

Pattern Panel depicts all patterns. TopNMethod Panel shows 2 tabs – one in red and one in blue. The 

red one denotes patterns with high response times and blue one denotes patterns with high call 

count. In the figure above, the first row in table in TopNMethod panel depicts that pattern with top 

level function CSFConsumerBase.ejbCreate() was called 57 times and it took 15 milliseconds to 

execute it. 

Pattern Panel 

TopNMethod Panel 

Pattern Detail Panel 
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This version also provides a feature for searching the Patterns Tree. For more details regarding the 

Search feature refer the “Operational Details for Searching Trees” under the Section 9.2. 

Pattern Detail Panel depicts a table with 4 columns, viz 

Level in the pattern : - Jensor terms methods called by run-time environments as Level 0 (zero) 

methods. This column depicts the pattern depth. 

Function Name :- Name of the function at a given depth. 

Response Time :- Time taken to complete all invocations of this method in milliseconds. 

Call Count :- Number of invocations. (see example below for correct interpretation of this term). 

 

In example depicted above, 61 calls to the pattern completed in 2 milliseconds. It is important to 

note that the pattern repeats 61 times. It does not necessarily mean that every function at 

every level of depth repeats 61 times. It could also be that methods at level 0-3 execute only 

once, but method at level 4 executes in a loop 61 times. Future versions of Jensor will improve 

upon this feature. 

 

The number of patterns that JAW can detect is dependent on the depth of call tree that JAW is 

configured to look at. The deeper JAW can look into the call tree, the more patterns it can generate. 

By default JAW can look 4 levels deep. For e.g. if a call trace looks like A() –> B() –>C() –>D() –> E() 

then by default JAW will be able to see only upto D(). To instruct JAW to look deeper, one needs to 

change JAW properties by invoking Mode -> Change Properties menu. 
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Fig. 14. Change JAW Properties 

 

After configuring the desired pattern depth, one needs to regenerate patterns by invoking Mode -> 

Pattern Analysis menu.
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9.5 Viewing Method Histogram and Memory Usage Charts 

The Charts module depicts two charts namely 1) Method Response Time Histograms and 2) Memory 

Usage charts. The Charts take memusage.csv and topNMethods.csv as inputs. These files are 

output by Jensor and can be found in JENSOR_HOME\output directory. The Charts module is 

invoked by navigating to Mode -> Analyze -> Charts  

 
 

Fig. 15.Method Histograms and Memory Charts 

 

The bar charts in upper frame depicts method response time histograms. The frame depicts the top N 

bottleneck methods at a given instant of time. For example, the chart above depicts that at 15:51:38 

365, java2d.AnimatingSurface.run() is the method which has maximum execution time in the JVM.  

Across 5 (five) calls, this method has spent 2730 milliseconds under execution. The format of the 

method histogram is function name : frequency on one axis and cumulative response time in 

milliseconds on the other axis. 
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The line charts in the lower frame depict memory consumption. X-axis of this chart is time of the day 

and Y-axis is memory usage measured in MB. Both Charts, histogram and memory usage charts are 

synchronized on time. When the Play button is depressed, the animation begins. In the top frame it 

depicts the bottleneck response time at a particulat instant in time. In the lower frame the cross-bar 

moves depicting the exact memory usage at the same point in time. Thus a strong correlation 

between memory comsumption and running methods is established. Users can use this data for 

further analysis. To get detailed memory usage click on Memory Usage for Full Duration. A small 

window pops up. Graph in this window can be zoomed in and out to perform detailed analysis. 

 
 

Fig. 16. Memory for Full Duration 

 

Area is selected using the dragging operation of mouse. 

 
Fig. 17. Zooming-in Memory for Full Duration 

 

The selected area is then zoomed into, showing details of that time duration. Note that time between 

16:25 and 16:31 is selected. 
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Fig. 18.  Memory for required duration 

 

Events in time period 16:25 to 16:31 are magnified.
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9.6 Viewing Unexited Methods 

Methods which don‟t exit are of special interest. They provide an interesting insight into reliability of 

application under test. There are two modules related to unexited methods viz Unexited and 

Unexited – Details. They can be invoked through Mode -> Analyze -> Unexited menu. 

 
Fig. 19. Unexited Methods 

 

The left hand side frame depicts threads which have unexited methods. The right hand side frame 

depicts methods in that thread which have not exited. A method can be unexited under the following 

circumstances 

1. If a method stalls for a long time and does not return to its caller. 

2. A method throws an exception and exits via an alternate path to the runtime. 

3. A method is designed never to exit (similar to a daemon thread). 

Knowing which methods have not exited can thus provide a pointer towards application functionality,  

performance, scalability and reliability. This section provides details only about methods which have 

not exited. This module depends on how deep JAW is allowed to see. By default it can see methods 

as deep as the Debug Trace / Call Tree module can see.If the depth of a call tree is altered it will 

reflect in this module after regenerating the results. Jensor marks an unexited method by assigning it 

a response time of -1 (minus one). 
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Unexited – Details module differs from this module in a very small way. Unexited – Details presents 

entire call trace where as Unexited module only provides details on those calls that have not exited. 

The figure below depicts Unexited – Details. 

 
Fig. 20. Unexited methods -Details 

 

The columns of the table in right hand side frame are explained below.  

 Sr. No :- Serial number, just an identifier to identify how many calls are made in this call trace. 

 Level :- Depth at which this method is executed. 

 Function Name :- Function name 

 Entry Time :- This information is suppressed in this version of Jensor. Future versions will 

release it. 

 Call count :- Number of invocations of a method at a particular level. In this version of Jensor 

it will be uniformly 1. 

 Total / Avg / Max / Min response time :- Response time in milliseconds. Unexited methods 

have a response time of -1 (minus one) and are marked in grey. 

This version also provides a feature for searching the Call Trees in case of Unexited and Unexited - 

Details. For more details regarding the Search feature refer the “Operational Details for Searching 

Trees” under the Section 9.2. 
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9.7 Tagging Engine 

This section describes 3 modules – Tagging, Pie-Chart and Nested Pie-Chart. Tagging can be 

invoked by navigating to Mode -> Tagging menu. Tagging allows a Jensor user to classify method 

into various categories by use of tags. For example, a method may be a JDBC method, belonging to 

application App1 and written by Vendor V1. Jensor allows you to attach multiple tags to a method and 

see a breakup of response times as per those tags.  

To use tagging engine, the following procedure needs to be followed. 

1. First, create tags using Mode -> Tagging -> Create Tags feature. So say a set of J2EE 

components or names of vendors etc can be created as tags. 

 

 
 

Fig. 21. Tagging Menu 
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2. A Tag is an identifier. One can create tags for representing technical as well as business 

perspectives. For e.g. the figure below creates tags to break down function calls into its Java 

Components like JDBC, Servlet, JMS, EJB, MDB etc. 

 

 
 

Fig. 22.Tag Creation 
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3. Save the tags by a name. For e.g. all the java components like JDBC, SERVLET, JMS are 

saved as, say JAVA_COMPONENTS ’tag file. 

 

 
Fig. 23. Tag Naming 

 

4. Next step is to Perform Tagging by invoking Mode -> Tagging -> Perform Tagging menu. 

5. Here you will be presented with a list of methods captured by Jensor. At one time, you can 

apply only one set of tags i.e. when performing tagging using JAVA_COMPONENTS you can 

tag a particular function as belonging to a particular Java component. Similarly, user can 

create a OperationsTag using tagging feature, which can include operations like UPDATE, 

INSERT, DELETE, CREATE etc. The next figure shows how to perform tagging using Jensor 

UI. 

 

 

 

 

 

 

 

 

 

 



Jensor 2.2 Usage Manual 

      44
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 24. Perform Tagging   

 

There are no limitations on the number of tags created. For each such tag created, one needs to 

do Perform Tagging for a tag to be useful during analysis. 

 

6. When creating Pie-Charts, the drop-down menu will automatically be populated with as many 

tags that have been created for that project. You can also import tags from other project using 

Import / Export Tags functionality. 

7. Nested Pie-Charts are also created in a similar way. Currently nesting is supported upto 4 

levels deep i.e. one can nest upto 4 tags in this version of Jensor. 

 

Using simple tagging, one can answer questions like 

 How much time is spent in different J2EE components like say JSP, Servlet, EJB, JDBC etc? 

 What is the performance of vendor delivered code? 

 In which functionality of the application has the highest / lowest response times? 
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Fig. 25. Simple Tagging : Component-wise breakdown 

 

The diagram above depicts that 38% of the time is spent in doing JDBC calls. 
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Fig. 26.Simple Tagging : Vendor-wise breakdown 

 

The figure above depicts that almost 81% of the time is spent in code written by Vendor2. 

 
Fig. 27. Simple Tagging : Functionality-wise breakdown 
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The figure above depicts that 48% of response times are attributed to CSA functionality of the 

application. 

Jensor also, provides advanced functionality. In this functionality, one can do nesting of pie-charts. So 

the following questions can be answered using Nested Pie-Charts.  

Lets say, we create tags for identifying J2EE components like EJB, JMS, JDBC, MDB, Servlet. Using 

Pie-charts as demonstrated above we wish to find where is the time spent in JDBC. So say we create 

another set of tags, say, Create, Delete, Insert, Update. Now the following questions can be 

answered. 

1. How much time out of JDBC operations is spent in Create, Delete, Insert, Update operations? 

2. How many J2EE components are doing Update operations? 

3. What operations is an MDB doing? 

 
Fig. 28. Advanced Tagging : Nesting tags 

 

The 1
st
 panel shows, response times broken up by J2EE components. It shows a total of 4763 

seconds of response time spent across various tiers. JDBC takes almost 38%. 2
nd

 panel shows JDBC 

broken down into its operations. It depicts that the JDBC tier does Updates and Inserts. 3
rd

 panel 

reverses the perspective and shows which all J2EE components do an Update. 4
th
 panel shows what 

MDB was doing, namely only updates.  

1 2 

3 4 
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Nested-Pie Chart or Advanced Tagging is a powerful tool which provides various different 

perspectives of looking at the same data. Tags can basically combine technical as well business 

perspective, hence this is a useful tool for business users as well. The next paragraph explains the 

procedure to use Tagging Engine. 

Import / Export Tags 

Performing tagging can be a tedious task since there can be thousands of functions. Hence Jensor 

supports import and export of tags. When exporting tags, the tags themselves along with functions to 

which these tags get applied are exporting. When importing tags one must ensure that the current 

project contains more or less the same methods as the Jensor project from which the tags are being 

imported. Jensor also supports exporting to and importing from file system. 

Breakup of Time spent by Package, Class and Method 

For getting the Breakup of Time spent by Package, Class and Method, the tags are created at the 

time of instrumentation itself. So the “package.taginit”, “package.tag”, “class.taginit”, “class.tag”, 

“method.taginit” and “method.tag” files are created. This helps the users in the sense that they need 

not go through the process of creating the tags manually. So the user will have the tags created by 

packages, classes and methods. Thus these tags will be available to the user by default. The user 

can use these especially to identify the package/class/method responsible for the highest response 

times. 

Especially with the Nested Tagging feature this will help the user as s/he can get the detailed 

understanding as to which Package is accounting for the highest response times.  Then going at a 

more granular level s/he can identify the class within that package which is taking the maximum 

response time. Again the user can go to one further level of granularity as to which method within that 

class is accounting for the highest response time. Thus the tags should be helpful in identifying as to 

where the time is being spent. 

Following figure shows the breakup of timings in Tagging Module. The first figure shows the breakup 

using the Simple Tagging(Pie-chart) module under Tagging. The second figure shows more detailed 

granular breakup of times using Advanced Tagging(Nested Pie-chart). 
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Fig. 29. Break up by Package, Class and Method (Tagging) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 30. Break up by Package, Class and Method (Nested Tagging) 
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9.8 Response Time Spectrum 

When all instances of response times of methods are plotted against time it actually resembles like a 

spectrum. Hence this module is called Response Time Spectrum. It can be invoked by navigating to 

Mode -> Analyze -> Response Time Spectrum. A response time spectrum provides an accurate 

picture on when and where response times degrade and to what extent. Methods can be chosen from 

packages and classes through the UI. The following diagram depicts a response time spectrum. The 

diagram can be zoomed in and zoomed out like in Charts module, to analyze events of interest in 

detail. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 31. Response Time Spectrum 

This picture depicts that response times for DatabaseService.getConnection() method degrades 

rapidly by about 30-times. Correlating this data with workload information will help in detailed analysis 

regarding scalability of the given method. 

 

From Jensor1.7 onwards, the display for the Response Time Spectrum has undergone a change. As 

displayed in the fig 31 above, a SplitPane has been used wherein the chart is getting displayed on the 

upper side of the SplitPane and the legend for the chart is getting displayed on the lower side. 

Another change is that the legend has been converted to a table, with first column in the table 

representing the color and the second representing the Function name. 
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9.9 Object Instantiations 

The “Object Instantiations” module helps the user in getting the details regarding the objects that get 

instantiated during the selected period. The period can be selected through the dialog box that 

appears wherein the user can select the day, the hour, the minutes and the seconds for the start time 

and the end time. Based on the period selected, you get to see the information related to the Object 

Instantiation on a table on the lower side. On the upper side the user can see the Memory usage 

related chart which will help the user to decide the time period for which s/he needs to view the Object 

Instantiations data. 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

Fig. 32. Object Instantiations 

 

 

All this can be done only if the data for Object Instantiations was collected for a particular session, 

else it will display a message as shown below. 
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Fig. 33. Data Unavailable for Object Instantiations 
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9.10 System Metrics 

System Metrics module of Jensor can be invoked through Mode -> Analyze -> System Metrics. 

System Metrics help the user in getting the detailed view of the System through metrics related 

to each of the following 

 Processor 

 Memory 

 Disk 

 Network or System Calls 

A sample display for the System Metrics tab for the Windows Platform is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 34. System Metrics display 

 

Jensor now captures System Metrics as well. In the current version, the Module is available 

for all Platforms. 
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The Windows metrics are collected from perfmon, for detailed understanding refer to the 

Object/Instance/Metric in the perfmon interface. For Unix platforms, the fourth quadrant varies 

depending on the OS and in case of non-Linux Unix Platforms, the fouth quadrant displays 

System call details instead of the usual Network details. The details related to the switches used 

in the sar command and the metrics captured are mentioned in the table below, for detailed 

understanding refer to the man page for sar. 

  

    LINUX SunOS AIX 

CPU 

Processor Time U %system u %sys u %sys 

Priviledge Time U %idle u %idle u %idle 

User Time U %user u %usr u %usr 

IOwait Time U %iowait u %wio u %wio 

Paging 

Page Write/sec B pgpgout/s g ppgout/s     

Page Read/sec B pgpgin/s p ppgin/s     

Page Faults/sec B fault/s p vflt/s r fault/s 

Available Mbytes R kbmemfree r Freemem     

Disk 
Tot Disk Read/sec B rtps b bread/s b bread/s 

Tot Disk Write/sec B wtps b bwrit/s b bwrit/s 

Network/ 
System 

Calls 

Bytes sent/sec n DEV txbyt/s         

Bytes Received/sec n DEV rxbyt/s         

Read System Calls/sec     c sread/s c sread/s 

Writes System Calls/sec     c swrit/s c swrit/s 

Table 4. Sar Switches and Monitored metrics 

 

The System Metrics module should work fine on any Unix Platform however it has been 

tested on machines with the following OS and JVM combinations – 

 RHEL 4 and 32-bit JVM 

 IBM AIX 5.3 and 64-bit JVM 

 Sun Solaris 10 and 64-bit JVM 
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9.11 Response Time based Statistical Analysis 

Response Time based Statistical Analysis module of Jensor can be invoked through Mode -> 

Analyze -> Response Time based Statistical Analysis.  

The Response Time based Statistical Analysis modules presents the analysis in the form of two 

charts. The first chart is based on Total Response time and the second one on Self time 

Total Response time refers to the sum total of all the response times recorded for a particular 

method across all its invocations.  

On the other hand, Self time or Time spent in Self refers to the time actually spent in executing a 

particular method across all its invocations. For instance let us consider a very simple case with only 

two method invocations such that A() calls B() and the response time for A is 50 msecs and for B it is 

20 msecs. In this case the Response time and Self time for B is 20 msecs but for A the Response 

time is 50 msecs and Self time is (Response time of A - Time spent in B) = 50-20 = 30 msecs. 

In figure 35, the Top 15 methods to be plotted are decided based on their Total Response times. So 

in this case all the methods are sorted based on their Total Response times and the Top 15 methods 

are chosen. For the Top 15 methods so decided, the chart indicates the different statistical values. 

For ease of identification, the Box and whisker plots are used. Details of Box and Whisker plots can 

be found at http://en.wikipedia.org/wiki/Box_plot 

For ease of understanding the different values are explained in the context of the first series plotted 

for the method com.tcs.jsp.eQuiz.GetQuizQuestionCmd.execute() which has been invoked 1274 

times. The values are namely, 

 Mean indicated by the black dot which is 68.33 msecs 

 First Quartile indicated by the bottom of the box which is 16 msecs  

 Third Quartile indicated by the top of the box which is 62 msecs 

 Median is indicated by the band near the middle of the box which is 31 msecs. 

 The ends of the whiskers indicate the maximum and minimum regular values 

respectively. The maximum is 125 msecs and the minimum is 15 msecs 

 Any data not included between the whiskers indicates outliers. 

The red box highlights the tooltip for this series which eases the identification of a few of the values. 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Box_plot
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Fig. 35. Response-time based Statistical Analysis 

 

Similarly, in figure 36, the Top 15 methods to be plotted are chosen after sorting based on time spent 

in Self or Self-Time. 

In this case different values are explained in the context of the first series plotted for the method 

com.tcs.data.DBManager.toDataSet(). The values are namely, 

 Mean indicated by the black dot which is 58.56 msecs 

 First Quartile indicated by the bottom of the box which is 16 msecs  

 Third Quartile indicated by the top of the box which is 47 msecs 

 Median is indicated by the band near the middle of the box which is 31 msecs. 

 The ends of the whiskers indicate the maximum and minimum regular values 

respectively. The maximum is 93 msecs and the minimum is 0 msecs 

 Any data not included between the whiskers indicates outliers. 

The red box highlights the tooltip for this series which eases the identification of a few of the values. 
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Fig. 36. Self-time based Statistical Analysis 

 

This module enables a pictorial view representing the statistical analysis of a limited set of methods. 

Thus maintains simplicity while providing all the different statistical values based on the response time 

data.  
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9.12  Probability Density Function 

Probability Density Function module of Jensor can be invoked through Mode -> Analyze -> 

Probability Density Function.  

Probability Density Function module presents the analysis in the form of line charts. A probability 

density function line graph provides an accurate picture on, how common are response time samples at 

exactly this value. Methods can be chosen from packages and classes through the UI. The following 

diagram depicts a probability density function. The diagram can be zoomed in and zoomed out like in 

Charts module, to analyze events of interest in detail 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 37. Probability Density Function 

 
Fig. 37 depicts the probability density function of the two methods. The topmost red point in a graph 
describes, 15% of response time samples of the function Controller.AfterLoginServlet.doGet has 50 
milliseconds response time. 
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9.13  Cumulative Distribution Function 

Cumulative Distribution Function module of Jensor can be invoked through Mode -> Analyze -> 

Cumulative Distribution Function.  

Cumulative Distribution Function module presents the analysis in the form of line charts. A cumulative 

distribution function line graph provides an accurate picture on, how common are response time 

samples at equal to or less than this value. Methods can be chosen from packages and classes through 

the UI. The following diagram depicts a probability density function. The diagram can be zoomed in 

and zoomed out like in Charts module, to analyze events of interest in detail. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 38. Cumulative Distribution Function 

 
Fig. 38 depicts the cumulative distribution function of the two methods. If we focus on red point across 
0.9 value from „Y‟-axis, It describes, 90% of response time samples of the function 
Controller.AfterLoginServlet.doGet has response time less than or equal to 1 second.
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Appendix 

1 Calibrations 

Jensor 2.2 is not calibrated yet, but because of the state machine based intelligence, it is almost 

always guaranteed to run faster than any Jensor 1.x series. The results will be published in later 

versions of this document or on Jensor blogs at http://sourceforge.net/apps/wordpress/jensor/ 

 

2 Resources 

Refer http://jensor.sourceforge.net and http://sourceforge.net/apps/wordpress/jensor/ for additional 

resources. 

http://sourceforge.net/apps/wordpress/jensor/
http://jensor.sourceforge.net/
http://sourceforge.net/apps/wordpress/jensor/

